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 DELHI PUBLIC SCHOOL, Durgapur  
QUESTION BANK  FOR mid-term examination (2018-19) 

CLASS-V 
 
 
 
 

A.Fill in the blanks: 

1.A __________ is a software application that helps you access the Internet.     

2. __________ is the default Web browser in Windows. 

3. The __________ button is used to reload a page on Internet Explorer.    

4. The Copy option is provided in the __________ menu of Internet Explorer.     

5. You can change the __________ to get a wider variety of results on the search engine. 

6. The __________ option helps you view the Web page as it would appear in the printout.     

7. The __________ helps you connect and interact with people and communities.     

8. A Web page is saved on your computer with the __________ extension. 

9. You have the option to create your own __________ in Favorites.     

10. __________ is the most commonly used social networking. 

11. ____________option used for removing unwanted part from a picture? 

12. _______________ tool contains redeye flaw? 

13. _______________Which button used to move selected picture to picture library in Picasa ? 

14.Picasa is a free software from__________  

15.  We can add pictures in picasa by clicking _______________ in the file menu . 

16. If a picture is too bright, _____________ tools can be used to correct this? 

17 If a picture is too darken, _____________ tools can be used to correct this? 

18. ______________ tool catch first attraction first to the viewers. 

19. ________________ remove minors blurs . 

20 _______________effects has “Intensity” and “Radius” as parameters?     

21. ______________options is used to make a picture collage in Picasa 3?  

22. When an image is removed from a collage, it is moved to the _______.  

23. When an image has low visibility in a collage, it can be made more distinctive by selecting the ______ 

      Option 
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24. _____________ button is used to select an audio file for the movie?   

25. The movie to be opened and edited is selected from ___________. 

26. __________ refers to the way one slide replaces the other in the movie.   

27. The area on the Scratch window where sprite creations come to life is called __________.     

28. The __________ option in the Sprite Library helps you import or modify objects. 

29. A game in Scratch 2.0 is saved with the __________ extension.     

30. Scratch blocks are arranged into __________ categories in the Scripts tab. 

31. Any script or block placed inside the __________ block keeps repeating. 

32. The __________ identify the placement of a sprite with respect to other objects on the stage. 

33. The __________ Scratch block category contains blocks to add visual effect to the game. 

34. The __________ block in the Motion option indicates the coordinates of the sprite on the stage. 

35. You can right-click a sprite in the Sprites list and select the __________ option to create another 

sprite. 

36. After you have created a game program, you should __________ it so that you do not lose it.     

37. To open a saved game, you need to __________ its name. 

38. You can colour the duplicate of a sprite by using the __________ tool.  

39. The Stage backdrop icon is located __________.     

40. The “key space pressed?” block is located in the __________ option. 

 B.One Word Answer:  

1. Which websites where people with similar interests, activities and backgrounds connect? 

2. In the web browser where do you type the web address? 

3.Give an example of search engine. 

4.What is the extension of a saved web page. 

5. Which option used To directly add image from a mobile phone or camera to Picasa. 

6. Which  feature allows us to remove unwanted regions from a picture?     

7. Which button show us how the image will look after it is cropped?     

8. Which tool is used if a picture is not clicked from the best angles? 

9. When pictures are clicked in low light, which flaws is observed in pictures?  

10. What is the area or object which first catches an observer’s attention called?     

11. Which effect has “Intensity” and “Radius” as parameters? 
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12. To make an image look like a picture taken from an instant camera, which one effects is used?    

13. The background colour can be changed in which effect?    

14. If the border is added to an image, then which option is used to make the border edges rounded?     

15. Which tab  is used to make a picture collage in Picasa 3?      

16. To apply a border to all the images in a collage, you should click onj which tool? 

17. Which Movie tab in the Movie Maker to change the screen size of the movie? 

18. Which tab should you open to edit the caption, font type, size and colour of the text in every scene of 

the movie?  

19. Which button is used to select an audio file for the movie?       

20. Which option will you select to shorten to audio if the audio track is longer than the movie?  

C. TRUE/FALSE 

1. Gmail is one of most popular search engine. 

2. Mozilla Firefox is one of most popular search engine. 

3.Internet explorer is default web browser. 

4.We can open the web page anytime for additional reference. 

5.You should share personal information on internet. 

6.You can reveal your  password to everyone. 

7. Picasa is a multimedia software. 

8. When pictures are added to Picasa, they are organized into library. 

9. The retouch option allows you to crop a picture. 

10.The straightened option is present in commonly needed fixes tab. 

11. The commonly needed fixes tab allow you to add add a caption on picture  using Polaroid option. 

12. You cannot carve the border of an image. 

13. Border can be applied of an image on Picasa. 

14. You can left click  the caption tag box and drag it any where. 

15. You cannot adjust outer as well as the inner thickness of the border around any picture. 

16.The picture collage option present in file menu. 

17.You cannot edit collage picture one created. 

18.The page format dropdown option  is present in setting tab. 
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19. The draw shadow option helps to add background on picture in Collage. 

20. The first slide of the movie does not allow changing background color. 

21. The remove option helps in removing the caption from a slide. 

22. The sequence of slide  can be changed by dragging  a slide from one place to Another. 

23. Truncate audio option helps in shortening the Audio. 

24. Transition refers  to the way one slide  replaces another slide in the movie . 

25. You cannot increases decreases of  a slide. 

26.When you open scratch window ,a cat sprite appears. 

27.You can con change the size of the object with the  brush tool. 

28.You cannot an imported sprite. 

29.A sprite have maximum two sprite. 

30.The script is a instruction for making game on scratch. 

D.MCQ 

1. Mark is chatting with his friends on a social networking website under his father’s supervision. An 

unknown person sends him a friend request and asks for his phone number. What should Mark do?     
(A)  He should share his phone number. (B) He should give a fake phone number. 
(C)  He should refuse to share his phone number.(D) He should ask his friend to give the latter’s phone 
number. 

2. John has gone to Gujarat for holidays. He wants to share photos and chat with his friends from there. 

Which one of the following options will help him do this?     
(A) Social networking website (B) Encyclopedia 
(C) Google (D) Wikipedia 

3. Reema wants to save a Web page from the Internet on her computer. She is unable to locate the Save 

As option. Where can she find this option?     
(A)  In the Edit menu (B) In the Tools menu 
(C)  In the Help menu (D) In the File menu 
4. Piyush has a few tilted pictures that he wants to fix. Which one of the following tools should he use?     
(A)  Cropping (B) Straightening 
(C)  Red-eye (D) Import 

5. While clicking a photograph of the Taj Mahal, Pritam accidentally included tourists in the frame. Which 
one of the following tools should he use?     
(A)  Cropping (B) Straightening 
(C)  Red-eye (D) Import 

6. Siddharth was clicking photographs at a party. He noticed that some of the people in the photograph 
had a red hue in their eyes. What is this defect called?     
(A)  Pink-eye flaw (B) Red-eye flaw 
(C)  Yellow-eye flaw (D) Blue-eye flaw 

 

7. Sonali clicked a photograph of a group of friends. She wants to gift it to one of her friends changing the 

image into black and white while keeping this friend’s face in colour. How will she achieve this?     
(A)  By using Fill Light tool (B) By using Shadow tool 
(C)  By using Focal B&W tool (D) By using Crop tool 
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8. Samrat clicked a photograph of a white stone sculpture, but the image is dull. Which one of the 
following effect can he use to correct it?     
(A)  Shadow (B) Glow 
(C)  Sharpen (D) Focal B&W 

9. Sumant clicked a photograph of a tree but the image had small areas of blurring. Which one of the 
following features can he use to remove blurring from the photograph?     
(A)  Sharpen (B) Focal B&W 
(C)  Glow (D) Fill Light 

10. Mihir wants to make his photographs look like it was taken from an instant camera. Which one of the 
following effects will he use?     
(A)  Fill Light (B) Border 
(C)  Polaroid (D) Crop 
11. Sartaj wants to add a border with sharp angular edges. He should set corner radius to:    
(A)  Low (B) High 
(C)  Middle value (D) Zero 

12. Roohani wants to add a meaningful quote to all her photographs. Which one of the following options 

should she use?     
(A)  Caption (B) Polaroid 
(C)  Border (D) Text 
13. Prashant is trying to print a collage in a 16:9 aspect ratio. Under which option can he change this?     
(A)  Picture Borders (B) Collage Type 
(C)  Page Format (D) Shadow Options 

14.  Mridul wants to add background music to a movie made in Picasa. The duration of the movie is 1 
minute. The audio files she can use can be of:     
(A)  1 minute (B) 3 minutes 
(C)  30 seconds (D) Any duration 

15. Vinayak wants to reduce the size of an audio clip to fit a Picasa movie. Which one of the following 
options should he use?     
(A)  Truncate audio (B) Fit photos into audio 
(D)  Loop photos to match audio (D) Reduce audio 

 

16. Miriam wants to add effects to her movie so that each image replaces the other in a different style. 
Which one of the following options she should use?     
(A)  Background music (B) Transitions 
(C)  Slide duration slider (D) Captions 

 

17. Hari is creating a car racing game. He has created a car on a racing track. He wants to add movement 

to the car. What should he use to accomplish this task?     
(A)  He should use scratch blocks. (B) He should use costumes. 
(C)  He should use different colours. (D) He should use the Sprites lists. 

 

18. Tim is developing a car racing game. He needs to draw the finish line for the game. Which tool should 
he use?     
(A)  Line tool (B) Brush tool 
(C)  Color shape tool (D) Paint tool 
 

19. Hari is creating a car racing game. He wants to create a track for the cars to race on. Which one of the 

following options should he use to accomplish this task?     

(A)  By using the Fill with color button   and selecting the colour 

(B)  By using the Brush tool   and increasing its width with the slider 
(C)  By using the Erase tool  
(D) By using the Color shape tool 
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E. Define  the following terms: 

1. Web browser  2. Search engine   3. Crop       4.Preview  5.Straighten   6.Redeye  7.Sharpen   8. Focal 

9.Transition.     10. Picture pile      11.Sprites   12. Costumes  

 

F. Complete the following steps : 
1.To Save a picture from webpage: 

Step 1-Rigit click on a picture . 

Step 2  ____________________ 

Step 3 ____________________ 

Step 4 Click on Save.   

 

2. To remove the redeye flow: 

 Step 1 Select a picture from picasa library 

 Step 2  Right Click the selected picture and click  the ____________________  option . 

 Step3 Click the redeye button from _________________________ tab. 

 Step 4 Drag the mouse on eye of selected picture. 

 

3. To apply  focal  B & W effect to a picture. 

 Step 1  Select a picture from picasa library. 

 Step 2_________________________________________________________________ . 

 Step3 _________________________________________________________________ 

 Step 4 Drag the mouse and select a point for focusing . 

 

4. To create a colloage: 

 Step 1 _________________________________________  

 Step 2 Click on create  tab. 

 Step 3 _________________________________________  

 Step 4_________________________________________  

 

5.  To create a Movie in Picasa :  

 

Step 1 _________________________________________  

 Step 2 Click on create  tab. 

 Step 3 _________________________________________  

 Step 4_________________________________________  

 

 

Syllabus:-  
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